Each week Cheshirites enjoy reading *The Cheshire Herald*. Established in 1953, it has become a town institution, providing complete news and photo coverage of the town. It is delivered to over 6,700 homes a week, and is read avidly by virtually every resident.

The town of Cheshire, located in central Connecticut close to the major interstates (I-84, I-691 and I-91), has long been known for being a small, attractive town close to many urban markets.

People are attracted to Cheshire because of its fine school system and the many other services offered. The 27,000 residents have a much higher than average per capita income. They have proven their concern for the future of the town by preserving their historical areas and supporting conservation efforts.

Cheshire is the fourth most affluent community in Connecticut, outside Fairfield County: Households earning $150k plus:

*Source: 2002 Projection of 2000 U.S. Census Bureau Data*

<table>
<thead>
<tr>
<th>Town</th>
<th>Households</th>
</tr>
</thead>
<tbody>
<tr>
<td>West Hartford</td>
<td>2,448</td>
</tr>
<tr>
<td>Glastonbury</td>
<td>1,923</td>
</tr>
<tr>
<td>Avon</td>
<td>1,714</td>
</tr>
<tr>
<td>Cheshire</td>
<td>1,698</td>
</tr>
<tr>
<td>Madison</td>
<td>1,564</td>
</tr>
<tr>
<td>Farmington</td>
<td>1,507</td>
</tr>
<tr>
<td>Guilford</td>
<td>1,381</td>
</tr>
<tr>
<td>Simsbury</td>
<td>1,235</td>
</tr>
</tbody>
</table>

Cheshire is a highly educated market.
Percent High School Graduate or Higher: 92%
Percent Bachelor Degree or Higher: 48%

Cheshire's spending consistently ranks high

Cheshire, part of New Haven County, outspends most towns within its area. Out of 24 zip codes in this county, it consistently ranks in the top 7 in major expenditures, i.e. furniture, new automobiles, major appliances and travel.

### Local Display Advertising Rates

**Effective Sept. 1, 2015**

**Classified Rates**
- **Word Rate** - $0.50 for 20 words, 10¢ per word over 20 words.
- **Line Rate** - $2.00 per line.

**Classified Block Ads** - Call office for rates or visit our website.

### Legal Rate
- $1.65 per line

### Display Legal Rate
- For ads 2 or more columns wide $10.75 per inch.

### Probate Notice
- $50.00

### Liquor Permit
- $120.00 (2 Insertions)

### National Rate
- $14.25 per column inch. Subject to agency discount of 15%

### Obituary Rate
- $11.00 per column inch.

### Inserts
- $485.00 per insertion. *Reduced contract rates available:* ($460 for 12 weeks, $435 for 26 weeks, and $350 for 52 week commitment.) Call us with insertion date as early as possible for reservation.

Maximum folded size: Finished piece (insert folded, quarter folded or flat) cannot exceed 8 1/2 x 11". (Note: Unusually heavy inserts may be subject to a higher rate due to the weight.) Inserts are to be delivered directly to our printer at The StepSaver/Observer, 213 Spring Street, Southington, CT 06489. Clearly mark or label each box “The Cheshire Herald” and the date it is to be inserted.

### Color Rates Per AD

- 1-9.5" - $30
- 10-14.5" - $35
- 15-19.5" - $40
- 20-29.5" - $50
- 30-39.5" - $75
- 40-59.5" - $105
- 60-77" - $135
- Full Page - $155

### Proof Ads

Proofs of advertisements are shown for correction only. Revisions of any kind are subject to additional costs based on time required for such revisions and will be made providing revisions will not delay publication. Ads which the advertiser wishes to see before their publication must be received by 3 p.m. on the Friday before publication. *Copy changes on proofs must be received by 3 p.m. on the Monday prior to publication.*

### Preferred Position

Add 15% for specific page and/or for location on page (1/4 page minimum), when granted. We will try to accommodate position when possible. Position will not be granted if it delays the publication of The Cheshire Herald.

**Publisher reserves the right to reject any advertising whether wholly or in part if deemed unsuitable. Publisher liability for errors/omissions in copy shall not exceed the cost of the space in which the error/omission occurs in the first insertion. Advertisers must inform The Herald of that portion of the ad that is incorrect after the first insertion or be liable for the succeeding errors that are printed in future ads. In no event shall The Cheshire Herald be liable for consequential damages of any kind. No cash adjustment.**

**Billing Terms:**

Statements are payable upon receipt on approved credit. A signed, completed credit application must be submitted and approved before any credit will be extended, otherwise, cash in advance. We accept Visa, MasterCard, American Express and Discover credit cards. Issuance of credit is at the sole discretion of the publisher. All cards of thanks, liquor notices and social notices require cash with order. All statements must be paid in full by the end of the month following ad insertion. Interest of 1.5% per month (18% per annum) will be charged on past due accounts. Any accounts with outstanding balances are subject to immediate cancellation of credit.

**Above rates apply if paid in advance or net 30 for billed accounts.**

**Full Page** ................................................................. $848.63

**Centerfold (Full Color Included)** ................................. $2116.98

We gladly accept ads in .pdf format at

Sales@cheshireherald.com

Revised 04/18
Frequency discount is provided to customers with a signed contract on file. Customers must have a signed, approved, credit application. Payments are accepted by check, Visa, Mastercard, American Express or Discover Card. Prices effective Feb. 2016.
The Cheshire Herald newspaper has been published weekly in Cheshire since 1953.

As one of the last remaining independently owned news publications in the state, we remain committed to providing top-quality coverage of the events and issues that shape our community while also providing a forum for readers to share their thoughts and ideas.

Cheshire is a high-quality market, located in the central part of Connecticut close to major interstates (I-84, I-91/I-691). The town has long had the reputation of being an attractive suburban community nestled between many urban markets. People are drawn to Cheshire because of its stellar school system and numerous services offered.

Each week, the citizens of Cheshire look forward to reading about their community in the pages of The Cheshire Herald. It has become a town institution, providing news and photo coverage of every conceivable event, from board meetings to football games and everything in between.

Copies are delivered to paid subscribers by second-class mail and available at most newsstand locations.
### FREQUENCY DISPLAY ADVERTISING RATES

<table>
<thead>
<tr>
<th>Current Rate/PCI</th>
<th>$10.25</th>
<th>$9.80</th>
<th>$9.30</th>
<th>$8.75</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ROP</strong></td>
<td><strong>6 CONSECUTIVE WEEKS</strong></td>
<td><strong>13 CONSECUTIVE WEEKS</strong></td>
<td><strong>26 CONSECUTIVE WEEKS</strong></td>
<td><strong>52 CONSECUTIVE WEEKS</strong></td>
</tr>
<tr>
<td>Full Page</td>
<td>$794.38</td>
<td>$759.50</td>
<td>$720.75</td>
<td>$678.13</td>
</tr>
<tr>
<td>1/2 Page</td>
<td>$410.00</td>
<td>$392.00</td>
<td>$372.00</td>
<td>$350.00</td>
</tr>
<tr>
<td>1/3 Page</td>
<td>$276.75</td>
<td>$264.60</td>
<td>$251.10</td>
<td>$236.25</td>
</tr>
<tr>
<td>1/4 Page</td>
<td>$215.25</td>
<td>$205.80</td>
<td>$195.30</td>
<td>$183.75</td>
</tr>
<tr>
<td>1/8 Page</td>
<td>$102.50</td>
<td>$98.00</td>
<td>$93.00</td>
<td>$87.50</td>
</tr>
<tr>
<td>1/16 Page</td>
<td>$61.50</td>
<td>$58.80</td>
<td>$55.80</td>
<td>$52.50</td>
</tr>
<tr>
<td>Business Card</td>
<td>$41.00</td>
<td>$39.20</td>
<td>$37.20</td>
<td>$35.00</td>
</tr>
</tbody>
</table>

Frequency discount is provided to customers with a signed contract on file. Customers must have a signed, approved, credit application. Payments are accepted by check, Visa, Mastercard, American Express or Discover Card. Prices effective Feb. 2016.

*Price per week.

### DISPLAY ADVERTISING SIZES

- **Full Page**
  - (5 col. x 15.5”)
  - 10” x 15.5” = 77.5”

- **1/16 Page**
  - (Horizontal 2 col. x 3”)
  - 3.875” x 3” = 6”

- **1/4 Page**
  - (3 col. x 7”)
  - 5.875” x 7” = 21”

- **1/3 Page**
  - (3 col. x 9”)
  - 5.875” x 9” = 27”

- **1/8 Page**
  - (2 col. x 5”)
  - 3.875” x 5” = 10”

- **1/2 Page (Vertical)**
  - (4 col. x 10”)
  - 7.875” x 10” = 40”

- **1/2 Page (Horizontal)**
  - (5 col. x 8”)
  - 10” x 8” = 40”

### COLOR RATES PER AD

- \(1 - 9.5”\)  $30.00
- \(10 - 14.5”\)  $35.00
- \(15 - 19.5”\)  $40.00
- \(20 - 29.5”\)  $50.00
- \(30 - 39.5”\)  $75.00
- \(40 - 59.5”\)  $105.00
- \(60 - 77”\)  $135.00
- Full Page  $155.00

**Policy**

All Classifications: Publisher reserves the right to reject any advertising whether wholly or in part if deemed unsuitable. Publisher liability for errors/omissions in copy shall not exceed the cost of the space in which the error/omission occurs in the first insertion. Advertisers must inform The Herald of that portion of the ad that is incorrect after the first insertion or be liable for the succeeding errors that are printed in future ads. In no event shall The Cheshire Herald be liable for consequential damages of any kind. No cash adjustment.

**Billing Terms:**

Statements are payable upon receipt on approved credit. A signed, completed credit application must be submitted and approved before any credit will be extended, otherwise, cash in advance. We accept Visa, MasterCard, American Express and Discover credit cards. Issuance of credit is at the sole discretion of the publisher. All cards of thanks, liquor notices and social notices require cash with order. All statements must be paid in full by the end of the month following ad insertion. Interest of 1.5% per month (18% per annum) will be charged on past due accounts. Any accounts with outstanding balances are subject to immediate cancellation of credit.
PIVIROTTO REMODELING
Specializing in kitchens & baths

CALL LARRY PIVIROTTO (203) 271-3093

PIVIROTTO REMODELING
Specializing in kitchens & baths

PIVIROTTO REMODELING
Specializing in kitchens & baths

THAI HUT
Catering•Take-Out•Dine-In
Daily Specials Available

Enjoy authentic Thai cuisine served
in a cozy & elegant atmosphere.

From Thai Noodles and Fried Rice
to Native Thai Yellow Curry Dishes,
you will be certain to have
an experience to remember...

181 Main St., Southington
OPEN 7 DAYS
Mon-Wed 11am - 9pm; Thur-Fri 11am - 10pm; Sat 11:30am-10pm; Sun 11:30am - 9pm

www.ThaiHutSouthington.com
Catering•Take-Out•Dine-In
Daily Specials Available

Appetizers
Soups
Spicy Curry
House Specials
Desserts

Call Larry Pivirotto (203) 271-3093
Fully insured Lic. No. 533110

PIVIROTTO REMODELING
Specializing in kitchens & baths

FULLY INSURED
Lic. No. 533110

PIVIROTTO REMODELING
Specializing in kitchens & baths

Full Page $155.00

COLOR RATES PER AD
1 - 9.5" $30.00
10 - 14.5" $35.00
15 - 19.5" $40.00
20 - 29.5" $50.00
30 - 39.5" $75.00
40 - 59.5" $105.00
60 - 77" $135.00
Full Page $155.00

www.cheshireherald.com
General Overview: Black & White Ads vs. Color Ads

**Black & White Ads**
1. Colors should all be greyscale, not RGB.
2. Colors should only show values in K in CMYK mode and not values of C, M, or Y

**Full 4 Color Ads**
1. Colors must be in CMYK format, no RGB files (including pictures/logos)
2. Any type that is Black must only have values of K in CMYK and not values of C, M, or Y

**Converting color files with Photoshop**
1. Black and White - Image > Mode > Greyscale
2. 4 Color - Image > Mode > CMYK

**Converting color files in Illustrator**
1. Black and White/4 Color - File > Document color mode > CMYK (prepares document to enter printing mode instead of RGB)
2. Black and White ads only - select all objects including type, in the menu go to: Filter > Colors > Convert to Greyscale
3. Color swatches should only contain number values of C,M,Y,K
   ie) **RED** C=0 M=100 Y=68 K=5
4. Never use “Register Black” as a swatch for Black use “Black” (k=100)

**Converting color files in Indesign**
1. Make sure all imported pictures/logos are Greyscale or CMYK
2. Color swatches should only contain number values of C,M,Y,K
   ie) **RED** C=0 M=100 Y=68 K=5
3. Never use “Register Black” as a swatch for Black, use “Black” (k=100)

**Converting color ads in Acrobat (7.0)**
1. Black & White ads only - Tools > Print Production > Convert Colors
2. Look at box that says “Document colors” that lists several modes such as “Device CMYK:...”Make sure each say “Convert” not “Preserve.” To change to “Convert,” look at “Action” (underneath the listed box) and select “Convert”
3. Under “Destination Space/Profile” select Gray Gamma 1.8 or Gray Gamma 2.2 > OK
5. When converting to 4 color, make sure all black text has only values of K (conversion might change black text to full color)
DISPLAY ADVERTISING

COLUMN INCHES (WIDTH)
1 Column ad = 1.875 Inches Across
2 Column ad = 3.875 Inches Across
3 Column ad = 5.875 Inches Across
4 Column ad = 7.875 Inches Across
5 Column ad = 10 Inches Across

FIVE COLUMNS TO A PAGE
Full page advertisement 10" x 15.5"
Centerfold 21.25" x 15.5"

DEADLINES
Display Advertising
Monday 3 p.m.

Special Sections
Thursday prior to publishing

Proof Ad Deadline
Friday 3 p.m. prior to next Thursday's insertion

Special Sections
Monday, one week prior to publishing
INSERTS INFORMATION

Rates For Pre-printed Inserts

$485.00 per insertion (2 pages or more)

Reduced contract rates available:

$460.00 per insertion — 12 week contract
$435.00 per insertion — 26 week contract
$350.00 per insertion — 52 week contract

Special: 1 page only Insert - $325.00

Call us as early as possible to reserve insertion date.

Maximum folded size: Finished piece (folded, quarter folded or flat)
cannot exceed 8 1/2” x 11”

(Note: Unusually heavy inserts may be subject to a higher rate due to the weight.)

Inserts are to be delivered directly to our printer at
The StepSaver/Observer, 213 Spring St., Southington, CT 06489.

Clearly mark or label each box “The Cheshire Herald” and the date to be inserted.

For additional information, please call the Advertising Department at:

203-272-5316

Directions to The StepSaver/Observer:
I-84 Exit 32 (CT-10/Queen St.) One block North of I-84 overpass is the light at Spring Street. Turn left onto Spring. StepSaver/Observer is approximately 1/2 mile down, on the right.
CLASSIFIED ADVERTISING

Classified Ad Rates

*The Cheshire Herald* is published weekly on Thursday. Classified ads are included in the E-Edition of the newspaper and also are updated on the Web site at www.CheshireHerald.com each Friday.

We charge a base rate of $9.50 for twenty (20) words. Each additional word is .10 cents per word. Please note, a word includes abbreviations, acronyms, street addresses, articles (a, the), e-mail addresses and phone numbers.

Classified line rates apply when set line for line ($2.00 per line)

Please note, a word includes abbreviations, acronyms, street addresses, articles (a, the), e-mail addresses and phone numbers.

**Example of word ad:**

DUMP RUNS- Clean outs, junk, furniture, appliances, metal, wood, brush from homes, condos, garages, attics, basements, barns, businesses, yards. (860)669-5984, (203)216-8164.

**Example of line ad:**

MULCH & WOOD CHIPS
Free Delivery
Native Wood Chips
4-6 yds @ $12/ yd + tax
8-10 yds @ $11/ yd + tax
$50 min. order
Call For Mulch Prices
Leavenworth Tree Farm & Services, LLC
(203)272-2543

MAKE YOUR AD STAND OUT FROM THE REST! ADD ON:

- **PHOTO**
  - $5 EACH p/ week

- **LOGO**
  - $5 EACH p/ week

- **Italics**
  - $1 EACH p/ week

- **Stars ★★★**

- **Underline**

- **UPPERCASE**

- **BOXED**
  - Need it hauled away? We do that! From house and yard- All types of debris and brush hauled. Gregory's Hauling (203)235-6210
  - $3 EACH or 2 FOR $5 p/ week

- **BOLD TYPE**

- **ART**

- **BURST**
  - 15% OFF
### Classified Block Ads 2015 Rate Sheet

#### 2 Columns x 2 Inches (3.9” x 2”)

<table>
<thead>
<tr>
<th>Duration</th>
<th>Cost per week</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Week</td>
<td>$53.30</td>
</tr>
<tr>
<td>4 Weeks (5% Discount)</td>
<td>$50.63</td>
</tr>
<tr>
<td>13 Weeks (10% Discount)</td>
<td>$47.97</td>
</tr>
<tr>
<td>26 Weeks (15% Discount)</td>
<td>$45.30</td>
</tr>
</tbody>
</table>

#### 2 Columns x 3 Inches (3.9” x 3”)

<table>
<thead>
<tr>
<th>Duration</th>
<th>Cost per week</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Week</td>
<td>$74.90</td>
</tr>
<tr>
<td>4 Weeks (5% Discount)</td>
<td>$71.15</td>
</tr>
<tr>
<td>13 Weeks (10% Discount)</td>
<td>$67.41</td>
</tr>
<tr>
<td>26 Weeks (15% Discount)</td>
<td>$63.66</td>
</tr>
</tbody>
</table>

#### 2 Columns x 5 Inches (3.9” x 5”)

<table>
<thead>
<tr>
<th>Duration</th>
<th>Cost per week</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Week</td>
<td>$113.50</td>
</tr>
<tr>
<td>4 Weeks (15% Discount)</td>
<td>$96.47</td>
</tr>
<tr>
<td>13 Weeks (20% Discount)</td>
<td>$90.80</td>
</tr>
</tbody>
</table>

### 1 Column Display Rates

<table>
<thead>
<tr>
<th>Sizes</th>
<th>Cost per week</th>
</tr>
</thead>
<tbody>
<tr>
<td>1x3”</td>
<td>$45</td>
</tr>
<tr>
<td>1x4”</td>
<td>$52</td>
</tr>
<tr>
<td>1x5”</td>
<td>$60</td>
</tr>
<tr>
<td>1x6”</td>
<td>$67</td>
</tr>
<tr>
<td>1x7”</td>
<td>$75</td>
</tr>
<tr>
<td>1x8”</td>
<td>$82</td>
</tr>
</tbody>
</table>

All prices include placement on *The Cheshire Herald* website and our E-Edition weekly.
Look to www.cheshireherald.com to find out what’s happening in Cheshire daily between issues. View classified ads, obituaries, legal notices, sports updates and so much more. Now you can find out all the who’s, what’s and where’s ....Anytime

OUR STATISTICS:
Average Traffic Per Month
31,000 Visits Per Month
9,000 Unique Visitors
346,275 Pageviews Per Month

Your business will be seen by thousands of local customers.

BANNER AD 863X120 PIXELS $40/wk.

TILE AD 350X314 PIXELS $50/wk.

MASTHEAD AD 160X80 PIXELS $30/wk.

All other Web ads will have at least two ads in the rotation at all times—appearing MOST of the pages of the website. You may pay double rate and increase your ad’s probability of appearing. *Ads shown are not actual size.

Acceptable Media:
All ad cost includes design. If you would like to supply Your own artwork please use the following guidelines: 72 DPI, RGB. Jpg. gif and Flash Media Accepted

CONTACT US AT 203-272-5316
**Hunting For That Easter Treat**

April 10, 2017

Easter is this coming Sunday but a special guest got things rolling early this past weekend when the friendly lion...
TRUE PUBLISHING DBA The Cheshire Herald
P.O. BOX 247 • 1079 SOUTH MAIN STREET • CHERISH, CT 06410
Phone (203) 272-5316 • Fax (203) 250-7145

CREDIT ACCOUNT APPLICATION

Please Fill Out Completely
* Required to process application

DATE ______________________
SALESPERSON ______________________

COMPANY PROFILE

Company Name ______________________
DBA ______________________
Type of Business: ☐ Sole Proprietorship ☐ Partnership ☐ LLC
☐ CT Corporation ☐ Corporation, in the State of ______________________
* Owner / Partner / President: ______________________
* Home Address ______________________
* Home Phone ______________________
* Social Security Number: ______________________
* No. of Years in Business ______________________

BUSINESS ADDRESS

Name ______________________
Street ______________________
City ______________________ State __________ Zip __________

Have you previously advertised with us? _______ Under What name? __________

TRADE AND BANK REFERENCES

* Bank: ______________________
   Name ______________________
   Address ______________________
   Phone ______________________
   Acct. # ______________________
   Type of Acct. ______________________
   Authorization Signature ______________________
   Fax ______________________

Trade (at least two) Note: BARTFORD COURANT and NEW HAVEN REGISTER WILL NOT PROVIDE CREDIT INFORMATION!

1. ______________________
   Name ______________________
   Address ______________________
   Phone ______________________
   City ______________________ State __________ Zip Code __________
   Fax ______________________

2. ______________________
   Name ______________________
   Address ______________________
   Phone ______________________
   City ______________________ State __________ Zip Code __________
   Fax ______________________

TERMS AND USAGE

Estimated Size of Ads ☐ 1/8 Page ☐ 1/4 Page ☐ 1/2 Page ☐ Full Page ☐ Other ______________________
Person Authorizing Purchases ______________________ Phone: ______________________
Accounts Payable ______________________ Phone: ______________________

ADVERTISING AGENCIES: PLEASE ATTACH COPY OF INSERTION ORDER AND LIST ACCOUNT NUMBERS AND CLIENTS

In consideration of The True Publishing Company extending credit to the applicant/undersigned, the undersigned agrees as follows:
1.) To pay the total amounts of monthly purchases in full by the 30th day of the month following the month of purchase.
2.) In the event of default in making such payment, to pay a FINANCE CHARGE of 11/2% (1.5%) per month on all past due amounts, which is an ANNUAL PERCENTAGE RATE OF 18%.
3.) If this account is not paid and is placed in the hands of an attorney for collection, to pay all costs of collection including reasonable attorney’s fees.
4.) The undersigned does certify that this is a Commercial Transaction and waives all rights under the provisions of Chapter 903a of the Connecticut General Statutes including the right to a notice and hearing of any Pre-Judgment Remedy.
5.) The undersigned gives permission to banks and credit references to disclose credit information.

   ______________________ (Ind. Or Partner) ______________________ (Corporation Name)
   ______________________ (Ind. Or Partner) by ______________________ (Duly Authorized)
   ______________________ (Corporation Name)
   ______________________ (Ind. Or Partner) by ______________________ (Duly Authorized)
   ______________________ (Corporation Name)
   ______________________ (Ind. Or Partner) by ______________________ (Duly Authorized)
   ______________________ (Corporation Name)

In consideration of the granting of credit by The True Publishing Co., pursuant to the above application, the undersigned jointly and severally guarantee(s) payment for all purchases made by said persons or companies, and further agrees to all the conditions and provisions above stated. Including waiver of notice and hearing as to any Pre-Judgment Remedy. Notice of default and/or demand is hereby waived.

Date ______________________ Signed ______________________

M E D I A K I T